
Introducing
QuarkXPress

QuarkXPress 6 is a powerful and complex program, and
whether you’re new to the subject or an old hand, it’s

best to begin at the beginning. This chapter details the wide
range of uses QuarkXPress is being put to around the globe,
points out the ways in which QuarkXPress can be of use
to you, illuminates the key new features of version 6, and
describes the basic metaphor on which the program is based.
There’s also a comprehensive list of the terms — clearly and
concisely defined — that we use throughout the book. So
whether you’re an expert or novice, please read on and pre-
pare yourself for a great adventure.

Looking at What QuarkXPress
Can Do

QuarkXPress is used by a long and impressive list of people.
Nearly three-quarters of all American magazines — including
Rolling Stone, Folio:, Wired, US, Macworld, and Reader’s Digest —
are produced with QuarkXPress, as are many newspapers
around the world. It’s also the best-selling page layout pro-
gram among professional design firms. QuarkXPress is the
leading publishing program in Europe, and the international
version of QuarkXPress — QuarkXPress Passport — supports
most Western and Eastern European languages. There’s also
a version for East Asian languages — Japanese, Chinese, and
Korean.

This edition of the QuarkXPress 6 Bible includes many
new layout and production tips culled from experienced
QuarkXPress designers, including about a dozen extended
expert techniques where designers share their production
secrets.

Note

11C H A P T E R

✦ ✦ ✦ ✦

In This Chapter

The QuarkXPress
approach to
publishing

The publishing
workflow

Speaking the
language

What’s new in
version 6

A refresher on
version 5 changes

✦ ✦ ✦ ✦

d541153 ch01.qxd  6/19/03  8:47 AM  Page 23



24 Part I ✦ Welcome to QuarkXPress

What does this information mean for you? It means that QuarkXPress can handle
sophisticated tasks such as magazine and newspaper page layout, as shown in
Figure 1-1, while its simple approach to publishing also makes it a good choice
for smaller projects such as fliers and newsletters.

Figure 1-1: Folio: magazine is just one of the 
thousands of magazines and other publications 
that use QuarkXPress.

QuarkXPress can also be a good choice for corporate publishing tasks such as mar-
keting collateral, ads, proposals, and annual reports, some of which are often dis-
tributed via print, Adobe Acrobat Portable Document Format (PDF), and the Web.
Long-document features make it a viable tool for books and other lengthy publica-
tions. Using QuarkXPress puts you in good company.

Discovering the QuarkXPress Approach
QuarkXPress is considered to be a page layout program. But what does that mean?
What can you do with it and how do you do it? Well, you can do everything from
writing letters and printing them on your laser printer to designing high-end glossy
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25Chapter 1 ✦ Introducing QuarkXPress

magazines that you send out for color separations and four-color printing. And, in
QuarkXPress, you can go beyond print to designing Web pages, PDF documents, and
XML (Extensible Markup Language) content. (XML content is media-independent
and can be output in a number of ways.) But, due to the paste-up method that lies
behind designing in QuarkXPress, it is better suited to some projects than others.

The paste-up method
You build pages in QuarkXPress using the paste-up method — so it literally feels as
if you’re creating little blocks of text and graphic elements, placing them on a page,
and then resizing and scooting them around until you’re satisfied. First, you set up
the basic framework of the project, including the page size and orientation, mar-
gins, number of columns, and so on. You then fill that framework with boxes that
contain text, boxes that contain pictures, and with lines, as shown in Figure 1-2.

Figure 1-2: This Macworld table of contents contains boxes for pictures and text, 
as well as ruling lines.

Because of the emphasis on boxes, QuarkXPress is considered to be a box-based
program. Although the idea of text boxes, picture boxes, and lines sounds simple
and straightforward, in the right hands it can generate truly impressive results.
These page elements are explained further in the “Speaking the Language” section
of this chapter.
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26 Part I ✦ Welcome to QuarkXPress

The right — and wrong — projects for QuarkXPress
Like other programs, QuarkXPress has its strengths and weaknesses. For example,
it’s great for producing a brochure that requires color separations and trapping. On
its own, it’s not so great for a textbook that requires scientific equations and foot-
notes. You can, however, meet special needs such as these by adding features with
XTensions, which are plug-in modules for QuarkXPress.

Although you can adapt QuarkXPress to almost any publishing need, its roots in
layout and print can cause problems. With the paste-up method and the emphasis
on boxes, the items you place on pages in QuarkXPress can end up being tied to
the pages. So changing or multipurposing the content has been difficult in the past
(although the XML support may help change that). In addition, QuarkXPress has a
lot of features and may be too much to learn for simpler projects.

In general, the following projects are ideal for QuarkXPress:

✦ Anything printed in four colors or more

✦ Books with a high level of design such as coffee-table books

✦ Magazines and newsletters

✦ Corporate identity pieces: letterhead, envelopes, business cards

✦ Marketing collateral, brochures, and fliers

✦ Advertisements and posters

✦ Novelty items and packaging

✦ Content that may need to be output in many different forms: print, PDF, Web,
and so on

The following projects may not fare as well, at least without XTensions:

✦ Books with footnotes and more complex indexes

✦ Books with headers and footers that change with the page content

✦ Text that includes scientific equations

✦ Text that relies on automatic numbering, such as an outline, or many num-
bered steps that change often

✦ Letters or articles that need to be distributed to many people for customiza-
tion (stick with Microsoft Word for this type of thing)

✦ Publications with a low level of design but a high level of editorial demands
(such as tracking changes)
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27Chapter 1 ✦ Introducing QuarkXPress

When deciding whether to use QuarkXPress, remember the old saying — use the
simplest tool for the job. Writing letters to friends in QuarkXPress is surely overkill,
but forcing Microsoft Word to lay out brochures is painful. And keep in mind that
just because QuarkXPress can do something doesn’t mean it will do it exactly the
way you want it or need it. Be prepared to experiment, adjust your workflow, and
add XTensions before solving your unique publishing situations.

The Publishing Workflow
Obviously, your publishing workflow will depend largely on where you work and
what you’re creating. A one-person newsletter operation will have a significantly
different workflow than a national newsmagazine. And a graphic designer creating
ads will work differently than a textbook publisher. But, in general, most workflows
reflect the need to play to a program’s strengths. This means, you let each program
in your publishing environment do what it does best. So you:

✦ Write in a word processor. Even if you’re working alone, you’ll benefit from
writing and editing text in a word processor. You can take advantage of the
superior spell checker and revision tracking in a program such as Microsoft
Word — while concentrating on the words rather than the layout. Then,
import the text into QuarkXPress for formatting.

✦ Draw in an illustration program. Yes, you can make curvy items in
QuarkXPress and combine text and graphics in dramatic ways. But for 
the ultimate flexibility, use an illustration program such as Adobe Illustrator
for your line art. You can then use the picture file in as many places as
you want.

✦ Prepare pictures in an image-editing program. Whether you’re starting with
scans, images from Photo CDs, files from digital cameras, or images you’ve
grabbed from the Internet, you’ll generally need to save the picture in an
image-editing program. Again, QuarkXPress does give you some cropping,
resizing, and retouching tools. But most images will benefit from the profes-
sional tools in a program such as Adobe Photoshop.

✦ Pull it all together in QuarkXPress. QuarkXPress is the place to design your
layout — the way your text and graphics interact with each other and with
other elements on the page. Once you get the structure of your pages in place,
you can start collecting the text and graphics files (from yourself or from oth-
ers), importing them into the QuarkXPress document, and formatting them as
you like.

✦ Print proofs, make revisions, and perform final output from QuarkXPress.
Whether your project will be printed on your laser printer or color separated
onto film by a service bureau, this is one of the reasons you’re using
QuarkXPress — for reliable output.
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28 Part I ✦ Welcome to QuarkXPress

✦ In a Web environment, there are great tools for creating Web pages and
maintaining Web sites’ organization and standards. QuarkXPress can pro-
duce Web pages, but rarely will it be your primary Web development tool.
Instead, think of it as a great tool to convert print documents to Web form
that your Web developers will further refine and integrate into your Web site
via specialized Web publishing tools and HTML editors.

In a workgroup, many of the steps in the publishing process are happening at the
same time. Writers are writing, artists are creating graphics and illustrations, and
photographers are submitting pictures. Meanwhile, a graphic designer is producing
the shell of a publication. When the contents are ready, he or she pops them into
place and makes them look good. Figure 1-3 shows the various components that
make up a QuarkXPress document.

Figure 1-3: A QuarkXPress document and 
the imported Word, EPS, and TIFF files 
used in it

But the beauty of QuarkXPress is that you don’t have to work this way. You can do
everything in QuarkXPress. If you’re a one-person, one-program shop, you can still
get a lot done. You can write in QuarkXPress, edit in QuarkXPress, import pictures
from a Photo CD directly into QuarkXPress, and be done.

Speaking the Language
To understand the way you put pages together in QuarkXPress, it helps to know
exactly what makes up a page. And if you can call the items on the page the same
thing that we call them — and the same thing that Quark calls them — it’s easier to
communicate with other users and to look things up when you’re confused.
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29Chapter 1 ✦ Introducing QuarkXPress

QuarkXPress documents for print consist, primarily, of pages, items, and contents.
To make these things look good, you use item attributes and styles. We’ll take a
quick look at each.

See Chapter 37 for information about the basic components of Web documents.

Projects and layouts
One of the biggest changes in QuarkXPress 6 is the concept of projects. Gone is the
old QuarkXPress term “document.” What’s the difference? Plenty. A project can be
made up of a typical print document, such as a magazine feature or a book chapter —
the definition of a document in previous versions of QuarkXPress. But it can also be
composed of multiple print documents, multiple Web documents, or a combination
of print and Web documents. These are all stored in the same file, the project.

QuarkXPress 6 calls each of these project components layouts. A layout is essen-
tially a collection of pages that have the same basic page setup (such as two-sided,
83⁄8"-×-107⁄8" pages) and content type (print or Web).

The project/layout concept is more than a semantic change. It lets designers group
related components into one file, rather than have separate files for one project.
Consider some applications: A print magazine that has a foldout table in an article
no longer needs a separate document for the foldout, with its different page set-
tings. A print magazine that makes Web versions of its features can now have the
print and Web versions in the same file, making it easier to ensure consistency. A
business report can combine two-sided pages with single-page chapter dividers.

In QuarkXPress 6, you work on one layout at a time — as if they were separate
documents — and you can convert a layout to another form (size, single-sided
versus two-sided, and Web to print or print to Web) at any time.

Pages and layers
Each project in QuarkXPress is made up of pages, which are outlined on your screen
in black. Depending on how you’ve set up the project, the pages may be side-by-
side in spreads and they may have margins and columns indicated by blue lines.
Generally, each page in a document will end up being a page in a printed piece. But,
sometimes you’ll have multiple “pages” on a page, such as with a trifold brochure
on an 81⁄2"-×-11" page or a page of business cards. Some pages can also be Web
pages.

You can create layers for pages, which function like clear overlays that you can
show, hide, and print as necessary. When you create a layer, it applies to all the
pages in a layout. Layers are handy for storing two different versions of text or

Cross-
Reference
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30 Part I ✦ Welcome to QuarkXPress

graphics in the same document. They’re also good for isolating items so you can
work on them without being distracted by other items on a page. A page consisting
of several layers is shown in Figure 1-4.

Figure 1-4: This M-Business product directory 
page consists of one layer for the pictures and 
one layer for the text.

Items and contents
To really understand QuarkXPress is to understand the distinction it makes between
items and contents. Items are things you draw on a page — such as squares, circles,
lines, and wavy shapes — and then fill with color, stroke (frame), rotate, and so on
You can also import text and graphics — contents — into items. The primary items
in QuarkXPress are picture boxes and text boxes, but there are also lines, text
paths, and tables.

Contents, as mentioned, are text and pictures. (QuarkXPress calls any imported
graphic a picture, whether it’s a logotype, a chart, a line drawing, or a photograph.)
Contents are always placed within an item — so you can have items without con-
tents but you cannot have contents without items. Figure 1-5 shows a picture (con-
tent) moving around within its box (an item).
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31Chapter 1 ✦ Introducing QuarkXPress

Figure 1-5: A picture box is an item and 
the picture you import into it is its contents.

The reason you need to understand the distinction between items and contents is
that QuarkXPress provides different tools and menus for handling them. The two
primary tools at the top of the Tool palette, the Item tool and the Content tool, are
designed to work with their respective page elements. (Although as QuarkXPress
has evolved, the tools have become increasingly flexible and their functions now
overlap quite a bit.) Generally, you select and manipulate items such as boxes with
the Item tool. And you select and modify text and pictures with the Content tool.
QuarkXPress also provides the Style menu for modifying the look of contents and
the Item menu for modifying the look of items.

Item types
The broad category of items in QuarkXPress consists of primarily boxes and lines.
You can create, format, and manipulate boxes and lines in basically the same ways —
the primary difference among the different types is what you can put inside them.
Figure 1-6 shows each type of item in QuarkXPress. You can create the following
types of items in QuarkXPress:

✦ Text boxes. A text box is a container for text. You need to create one to type,
paste, or import text.

✦ Picture boxes. A picture box is a container for any graphic that originated
outside QuarkXPress (in Adobe Photoshop, for example).

✦ No-content boxes. A no-content box is a box that cannot contain text or pic-
tures; they are primarily used for colored backgrounds and shapes.
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32 Part I ✦ Welcome to QuarkXPress

✦ Lines. A line is just what it sounds like — a straight, diagonal, curvy, or irregu-
lar line that you draw on the page as decoration.

✦ Text paths. A text path is like a line in shape, but you can flow text along it.

✦ Tables. A table is really a series of grouped and linked text boxes, which you
can use to format or import data.

Figure 1-6: Top row, from left to
right: a text box, a picture box, and a
no-content box filled with a diamond
blend. Bottom row, from left to right:
a line with a dotted line style, a text
path, and a table.

If all this sounds incredibly structured, you’ll be happy to know that the items are
flexible. You can convert the type of any boxes, so if you start out with a no-content
box, you can convert it to a text box. If you draw a nice curved line, then decide to
flow text on it, you can convert it to a text path. And if you draw an exquisite closed
shape with a line tool, you can convert it to any type of box so it can have contents.

Attributes and styles
By themselves, items and contents don’t look like much. It’s the attributes you
apply to the items and the styles you apply to the contents that bring your docu-
ments life.

Item attributes
Aside from adding content, you can do two basic things to items: add color and
stroke them. For boxes, you add a background color. To stroke boxes, you actually
specify a frame, including its width, line style, and colors. For lines and text paths,
you simply pick a color, width, and style. Of course, you can do a lot of other things
to items themselves, including rotating and skewing them. The Item menu, and in
particular the Modify command, provides the controls you need for applying
attributes to items.

For frames and lines, QuarkXPress provides various styles such as double lines and
dots, and it lets you create your own patterns with its Dashes & Stripes command
(in the Edit menu).
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Most publishing and graphics arts programs use the term stroke to mean adding a
border to an item, whether it’s a box or line. QuarkXPress never uses that term,
preferring frame for strokes on boxes and simply width for strokes on lines and
text paths. To make matters more confusing, other programs use the term frame
for what QuarkXPress calls a box. When it comes to QuarkXPress, remember that a
shape is a box and the border around it is a frame.

Text and picture styles
QuarkXPress provides all kinds of styles for formatting text and manipulating pic-
tures. You can select and apply options such as fonts, sizes, underlines, justifica-
tion, and much more to text. And you can resize, distort, and flip pictures at will.
When text is selected, the Style menu for text, shown in Figure 1-7, provides all the
options. (You can even save most of the formats you apply to text in style sheets
through the Edit menu.) When a picture is selected, the Style menu for pictures,
shown in Figure 1-8, provides options specific to that type of picture.

Figure 1-7: The Style menu 
for text

Tip
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Figure 1-8: The Style menu for pictures

What’s New in Version 6
The most significant change from QuarkXPress 5 to QuarkXPress 6 is the new project
approach to multi-layout documents. Or maybe it’s the capability to create produc-
tion-quality PDF files without needing Adobe’s Acrobat Distiller software. Or maybe
it’s the new synchronized text feature, where text that is used in multiple places has
one master source that, if changed, updates all versions of it, even though they have
different text and paragraph styles applied to them. Or maybe it’s the fact that
QuarkXPress now supports multiple undos and redos. Or maybe it’s the fact that
QuarkXPress 6 is Mac OS X–native — “Carbonized,” in Mac lingo. These are all sig-
nificant advances for QuarkXPress, and the most significant depends on what’s
most important to you.

QuarkXPress also has enhancements scattered throughout the program. For exam-
ple, Web-page creators can now make two-point rollovers and have dynamic page
links. Print designers can truly lock items on layers, paste a copy in the same loca-
tion as the original (paste in place), see full-resolution previews of images, get
smoother output of blends, and better work with tables.

Despite the significant new functionality and the refinements to the program,
QuarkXPress designers will find that the basics haven’t changed dramatically —
you’ll find some new features and some interface changes, but nothing that will trip
you up. If you’re making the transition from version 5 to version 6, skim through
this section to familiarize yourself with QuarkXPress 6.

Application-level changes
The new projects and layouts approach to document creation allows multiple-size
pages in one project, as well as print and Web documents in one project. This
brings with it a new menu, Layout.
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Multiple undos and redos is another powerful change in version 6, letting you go
back several steps and even undo multiple steps at once.

QuarkXPress 6 also abandons older operating systems: It now supports only
Mac OS X, Windows XP, and Windows 2000. You can save projects into 
QuarkXPress 5–format document files — each layout is saved as a separate
document — for compatibility with users on Windows 95, Windows 98, 
Mac OS 8.x, and Mac OS 9.x.

In the Macintosh version, QuarkXPress 6 now has the Window menu that the
Windows version has had for some time. This menu lets you get a list of open pro-
jects, as well as display and hide the many palettes. QuarkXPress for Windows
added this menu in version 4, although it didn’t manage the display of palettes
until version 6.

QuarkXPress 6 for Macintosh has a new QuarkXPress menu that contains
the Preferences menu option. This change conforms to Mac OS X’s interface
standards.

New features
In addition to refining existing tools and capabilities, Quark has introduced addi-
tional features to make working in QuarkXPress 6 more efficient and exciting. The
new features are as follows:

✦ Synchronized text. This feature provides a way to handle boilerplate text
more efficiently. Such boilerplate copy could include copyright lines, page
folios, legal statements, product names, navigation bars, and other text that
needs to be consistent throughout a document. Even though text changes are
automatically applied to all instances of the synchronized text, you can apply
separate paragraph and character styles to the various uses of the synchro-
nized text and have those retained even when the text changes.

✦ Native PDF export. Exporting PDF files no longer requires that you own a
copy of Adobe Acrobat Distiller. Instead, Quark has built the PDF-creation
code right into QuarkXPress.

✦ Full Resolution Preview. This feature lets QuarkXPress 6 display pictures
onscreen using the picture file’s full resolution. This lets you scale or magnify
the image with minimal pixelation and lets you create more accurate
QuarkXPress clipping paths.

✦ Paste in Place. The new Paste in Place command in the Edit menu lets you
copy items to the same coordinates as the original — very handy when copy-
ing an item from one page to another. Before, the copy would appear in a
seemingly random location, so you’d have to know the X,Y coordinates to
move it to after making the copy.
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Enhanced features
Quark has refined several of the features introduced in version 5, making them
more powerful and easy to use.

Tables
You can now link table text cells to one another, or to any text box in a layout, for
more flexible text flow. You can now set the tab order of cells, letting you move from
cell to cell in the order that makes most sense for you.

Cells and gridlines can now assume the attributes of adjacent cells, saving you time
when inserting rows or columns that have the same formatting as adjacent rows
and columns. QuarkXPress 6 can remove gridlines, so that table cells abut one
another, and snap to a table gridline to onscreen guides for precise positioning.

Quark has also made subtle changes to how you apply color to table elements —
such as cells, the table box, and gridlines — to ease formatting. Also, you can now
apply clipping settings to pictures in picture cells.

You can convert a table to a group, which is useful when you save a layout contain-
ing features that are not supported in previous versions of QuarkXPress.

Layers
The Print dialog box now lets you specify which layers print. Even though you can
still check Suppress Output in the Attributes dialog box for each individual layer,
the addition of layer-printing controls in the Print dialog box lets you easily choose
on the fly what to print. 

Quark has enhanced how layers’ Suppress Output settings work. A layer’s Suppress
Output setting now overrides, but doesn’t modify, the Suppress Output settings for
each individual item on that layer. Thus, when you check Suppress Output for a
layer, none of the items on the layer print. And when you uncheck Suppress Output
for a layer, QuarkXPress honors the individual Suppress settings for each item on
that layer.

The locking behavior of layers is also improved. When you lock a layer, QuarkXPress
prevents items on the locked layer from being selected or modified. All the items on
the layer are locked. When you unlock it, QuarkXPress honors the Lock setting for
each item on that layer, which was designed to prevent accidental repositioning of
items via the mouse but allowed designers to change box and other settings
through palettes and dialog boxes.

A new command, Select All Items on Layer, is now available in the Layers palette
context menu.
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Printing
To print smoother blends when you output to a PostScript Level 3 device,
QuarkXPress 6 supports SmoothShading, which lets you print gradients without
using separate bands and static halftone values, resulting in improved quality in
printed blends from many devices.

QuarkXPress also supports As Is color, which retains the source color space during
output to a PostScript composite color device. This lets you manage color output at
the final printing device. You can apply As Is color to printed projects and EPS files
that you create in QuarkXPress.

The new support for Adobe PostScript’s DeviceN capability lets you output blends,
multi-inks, colorized TIFF images, and other items as composite color while retain-
ing their color-separation definitions. This lets you print proof copies on composite
devices such as inkjet and thermal-wax printers while retaining separation informa-
tion for eventual output to CMYK negatives or plates. You can apply DeviceN to EPS
files that you create using the QuarkXPress Save Page as EPS dialog box.

Web pages
You can create page-to-page hyperlinks within a print or Web layout. You can also
now use the Append feature to import hyperlinks into a project. Quark has enhanced
the Hyperlinks palette so you can specify how the palette displays hyperlinks and
anchors.

QuarkXPress 6 supports cascading menus, so you can create Web pages with a com-
prehensive user interface. Using cascading menus lets you simplify your design by
“hiding” menu items until the user moves the mouse pointer over a specific item.

The program also now supports HTML cascading style sheets, which specify fonts
for Web browsers to use, providing a series of alternatives if the browser doesn’t
have your first choice.

The two-position-rollovers feature of QuarkXPress 6 lets you add greater visual
interest to your Web pages. Because a two-position rollover lets you specify sepa-
rate origin and target boxes, you can make rollovers from text or picture boxes in
different areas of the page. For example, when a user passes the mouse over a
menu item, not only will that menu item’s color change as was possible using the
previous one-position-rollovers feature, but it will also let a text or picture box
become active, such as to show submenus or highlight options elsewhere on
the page.

To make previewing and exporting layouts more convenient, HTML Preview and
HTML Export features have been added to the context menu.
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There are several improvements to form controls in QuarkXPress 6:

✦ You can quickly create form boxes by changing the content of an existing box
to Form.

✦ You can place a form on a layer.

✦ You can create form boxes in table cells.

You can change the name of a browser in the Preferences dialog box.

You can specify additional export folders for pictures and rasterized text boxes in
Web layouts.

Avenue.Quark and XML import
Both the Avenue.Quark interactive-document and XML-import features have been
updated to include more comprehensive placeholder features and a more intuitive
interface.

A refresher on version 5 changes

If you’re jumping from QuarkXPress version 4 to 6 — many QuarkXPress users did not adopt
version 5, for a variety of reasons, including lack of native Mac OS X support — here’s what
you missed.

In version 5, power users noticed a few changes to the overall application: Required
Components, a new Preferences dialog box, and a streamlined Tool palette. The biggest
functional change in version 5 was the capability to create tables.

Version 5 of QuarkXPress included one significant change to the application itself — the
addition of Required Components. These small software modules add features such as
tables, HTML export, and GIF import to QuarkXPress. Unlike XTensions (optional add-ons
for QuarkXPress), Required Components must be present for QuarkXPress to run. Many of
Quark’s old XTensions, such as Cool Blends, now exist as Required Components. The idea
is that Quark can update and distribute these small modules without updating the entire
program. Plus, Quark no longer has to test the software in all the different configurations
with and without XTensions. Required Components are stored in a folder called Required
Components inside your QuarkXPress folder, which is where you should leave them.

One other across-the-board change was the Preferences dialog box. QuarkXPress used to
have two preferences dialog boxes — Application and Document — along with assorted pref-
erences for the various XTensions you were using. Now, the application has one big prefer-
ences dialog box for Application Preferences, Print Layout Preferences, and Web Layout
Preferences. Plus, you still get assorted preferences dialog boxes for XTensions. Even
though the preferences are all in one dialog box, accessed through QuarkXPress ➪

Preferences or Option+Shift+Ô+Y on the Mac, and through Edit ➪ Preferences or
Ctrl+Alt+Shift+Y in Windows), they still work the same:
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Summary
QuarkXPress is the most popular publishing application in the world — with good
reason. With its paste-up method of working and its flexibility, QuarkXPress is ideal
for projects that run the gamut from black-and-white garage sale fliers to newspa-
pers to glossy coffee-table books.

✦ Application Preferences apply to the QuarkXPress application, not to individual
documents.

✦ Print Layout and Web Layout Preferences apply to the active QuarkXPress document.
If no documents are open, they become program defaults.

QuarkXPress 5 also streamlined the Tool palette. Quark combined all the various types of
picture boxes into a single pop-out for picture box tools, and combined the two line tools
into a pop-out as well. If you create a Web layout, you get an additional Tool palette for cre-
ating items such as image maps.

QuarkXPress 5 also brought in a bunch of new menu items and enhancements, including
the following:

✦ Index palette. You can change the width of the Index palette. (Not a huge deal,
until you start trying to decipher the index entries at their default width.)

✦ Web documents. Create documents specifically for Web publishing, set up with the
measurements and tools you prefer.

✦ Interactivity. Add interactivity to Web documents with rollovers, image maps, and
hyperlinks. Incorporate tables and meta tags as well.

✦ XML content. Use the XML features of the included Avenue.Quark XTension to cre-
ate media-independent content.

✦ PDF. Add hyperlinks to exported PDF pages.

✦ Tables. Create tables that contain linked text cells and graphics.

✦ Layers. Use layers to organize components of a design or versions of content (such
as multiple versions of a similar ad).

✦ Underline Styles. Create custom underline styles — including color, shade, width,
and offset — and apply them to text.

✦ Line Check. Search for text-flow issues such as widows, orphans, and text overflow.

✦ Starburst tool. A free Quark XTension previously available for download was added
to the Tool palette; it lets you create — you guessed it — starburst boxes.
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To understand QuarkXPress, you need to understand the concepts of items (boxes
and lines) and contents (text and pictures). With version 6, you also need to
understand the concept of projects and layouts if you want go beyond the single-
document-at-a-time view of publishing. To work, you’ll need to know how to work
with these different elements, and to communicate you’ll need to know what to call
them. If you’re already familiar with QuarkXPress, you’ll appreciate the new fea-
tures for projects and layouts, undo, and synchronized text, as well as the enhance-
ments for tables, Web pages, PDF output, printing, and layers — plus, of course, its
newfound Mac OS X nativeness.

✦ ✦ ✦
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